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WARNING

CAUTION

NOTE

Safety Notices

This product and related documentation must be reviewed for familiarization with
safety markings and instructions before use.

This product has been designed and tested in accordance with accepted industry
standards, and has been supplied in a safe condition. The documentation contains
information and warnings that must be followed by the user to ensure safe operation
and to maintain the product in a safe condition.

The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material,
including but not limited to, the implied warranties of merchantability and fitness
for aparticular purpose. Agilent Technologies shall not be liable for errors contained
herein or for incidental or consequential damages in connection with the furnishing,
performance, or use of this material.

The following safety symbols are used throughout this manual. Familiarize yourself
with the symbols and their meaning before operating this instrument.

Warning denotes a hazard. It calls attention to a procedure which, if not
correctly performed or adhered to, could result in injury or loss of life. Do not
proceed beyond a warning note until theindicated conditions are fully

under stood and met.

Caution denotes a hazard. It calls attention to a procedure that, if not correctly
performed or adhered to, could result in damage to or destruction of the product. Do
not proceed beyond a caution sign until the indicated conditions are fully understood
and met.

Note calls out special information for the user’s attention. It provides operational
information or additional instructions of which the user should be aware.
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Failureto ground the analyzer properly can result in personal injury. Before
turning on the analyzer, you must connect its protective earth terminalsto the
protective conductor of themain power cable. Insert themain power cableplug
into a socket outlet that hasa protective earth contact only. DO NOT defeat the
earth-grounding protection by using an extension cable, power cable, or
autotransformer without a protective ground conductor.

If you are using an autotransformer, make sure itscommon terminal is
connected to the protective earth contact of the power source outlet socket.

Thisisa Safety Class 1 Product (provided with a protective earth ground
incorporated in the power cord). The mainsplug shall only beinserted in a
socket outlet provided with a protective earth contact. Any interruption of the
protective conductor inside or outside of the product islikely to makethe
product dangerous. Intentional interruption is prohibited.

If thisproduct is not used as specified, the protection provided by the
equipment could beimpaired. Thisproduct must be used in a normal condition
(in which all meansfor protection areintact) only.

No operator serviceable partsinside. Refer servicing to qualified personnel. To
prevent electrical shock do not remove covers.

For continued protection against fire hazard, replace fuses, and or circuit
breakers only with same type and ratings. The use of other fuses, circuit
breakersor materialsis prohibited.

Install the product so that the detachable power cord isreadily identifiable and
easily reached by the operator. The detachable power cord istheinstrument
disconnecting device. It disconnects the mains circuits from the mains supply
before other parts of theinstrument. The front panel switch isonly a standby
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switch and isnot a LINE switch. Alternatively, an externally installed switch or
circuit breaker (which isreadily identifiable and is easily reached by the
operator) may be used as a disconnecting device.

VENTILATION REQUIREMENTS: When installing the product in a cabinet, the
convection into and out of the product must not be restricted. The ambient
temperature (outside the cabinet) must be less than the maximum operating
temperature of the product by 4°C for every 100 watts dissipated in the cabinet. If
the total power dissipated in the cabinet is greater than 800 watts, then forced
convection must be used.

Thisinstrument has auto-ranging line voltage input, be sure the supply voltageis
within the specified range and voltage fluctuations do not to exceed 10 percent of
the nominal supply voltage.

Always use the three-prong AC power cord supplied with this product. Failure to
ensure adeguate earth grounding by not using this cord can cause product damage.

Thisinstrument has auto-ranging line voltage input, be sure the supply voltageis
within the specified range and voltage fluctuations do not to exceed 10 percent of
the nominal supply voltage.

The Mainswiring and connectors shall be compatible with the connector used in the
premise electrical system. Failure, to ensure adequate earth grounding by not using
the correct components may cause product damage, and serious injury.

To prevent electrical shock, disconnect the instrument from the mains (line) before
cleaning. Use adry cloth or one dlightly dampened with water to clean the external
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case parts. Do not attempt to clean internally.

The front panel switch is a standby switch only; it is not a LINE switch (power
disconnecting device).

Environmental requirements. This product is designed for indoor use only and to
meet the following environmental conditions:

» Operating temperature: 0° Cto +55° C
*  Operating humidity: <95% relative
» Altitude: up to 4500 m

Warranty

This Agilent Technologies instrument product is warranted against defectsin
meaterial and workmanship for a period of three years from date of shipment. During
the warranty period, Agilent Technologies Company will, at its option, either repair
or replace products which prove to be defective.

For warranty service or repair, this product must be returned to a service facility
designated by Agilent Technol ogies. Buyer shall prepay shipping chargesto Agilent
Technologies and Agilent Technologies shall pay shipping charges to return the
product to Buyer. However, Buyer shall pay all shipping charges, duties, and taxes
for products returned to Agilent Technol ogies from another country.

Agilent Technologies warrants that its software and firmware designated by Agilent
Technologies for use with an instrument will execute its programming instructions
when properly installed on that instrument. Agilent Technologies does not warrant
that the operation of the instrument, or software, or firmware will be uninterrupted
or error-free.




LIMITATION OF WARRANTY

The foregoing warranty shall not apply to defects resulting from improper or
inadequate maintenance by Buyer, Buyer-supplied software or interfacing,
unauthorized modification or misuse, operation outside of the environmental
specifications for the product, or improper site preparation or maintenance.

NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. AGILENT
TECHNOLOGIES SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

EXCLUSIVE REMEDIES

THE REMEDIES PROVIDED HEREIN ARE BUYER' S SOLE AND
EXCLUSIVE REMEDIES. AGILENT TECHNOLOGIES SHALL NOT BE
LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT,
OR ANY OTHER LEGAL THEORY.

Where to Find the Latest Information

Documentation is updated periodically. For the latest information about Agilent
NFA Noise Figure Analyzers, including firmware upgrades and application
information, please visit the following Internet URL.:

http://www.agilent.com/find/nf/
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Getting Started

This chapter introduces you to basic features of the Noise Figure Analyzer,
including front panel and rear panel descriptions, and an overview of the
display annotation.

13
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What You will Find in this Chapter

What You will Find in this Chapter

This chapter covers the following:

The Noise Figure Analyzer Features
Overview of the Front Panel
Overview of the Rear Panel

Display Annotation

Overview of the Front Panel Keys
Performing Common File Operations
Working with Tables

14
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The Noise Figure Analyzer Features

The Noise Figure Analyzer Features

3.0 GHz M echanical Switch

The N8974A and N8975A NFA models have a mechanica switch fitted to
allow them to switch between the 10 MHz to 3.0 GHz frequency range and
the 3.0 GHz to 6.7 GHz and the 3.0 GHz to 26.5 GHz frequency ranges
respectively. If the frequency range you are working in crosses the 3.0 GHz
point, the mechanical switch operates. The mechanical switch has alimited
number of cycles over which it isreliable.

To maximize the switches reliable life, switching over the 3.0 GHz switch
should be limited where possible.

Microwave Front Panel Connector

The N8974A and N8975A NFA models are fitted with a precision 3.5mm
male input connector. The models are supplied with a Precision 3.5mm
Coaxia Adaptor (83059B). When making connection you need to ensure
you apply the correct torque and you use the adaptor where needed. Correct
torque value guidance isin the Agilent NFA Series Performance
Verification and Calibration Guide.

Chapter 1 15
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Overview of the Front Panel

Figure 1-1 Front Panel Overview
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Table 1-1 Front Panel Item Descriptions
Item Description
1 Viewing Angle keys allow you to adjust the display.
2 The Esc (escape) key cancels any entry in progress.
3 Menu keys are the unlabel ed keys next to the screen. The menu key
|abels are shown on the display next to these unlabeled keys.
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Overview of the Front Panel

Table 1-1 Front Panel Item Descriptions
[tem Description
4 The MEASURE functions allow you to configure the NFA parameters

needed for making measurements.

The Frequency/Points and Averaging/Bandwidth keys activate the
primary set up function menu keys.

The Calibrate key removes any second stage noise contribution from
the measurement. The ENR key accesses the ENR menu.

TheMeas Mode and Mode Setup keys are used to configure the NFA
to measure mixers and devices at frequencies greater than the basic
frequency of the NFA using aLoca Oscillator.

The DISPLAY functions allow you to configure the display results.

The CONTROL functions alow you to setup the NFA's advanced
features.

SYSTEM functions affect the state of the NFA. Various setup and
alignment routines are accessed with the System key.

The green Preset key resets the NFA to a known state.

The File key menu allows you to save and |oad the various NFA file
types and access the File Manager. The Save Trace key executes the
Save function defined under File.

The Print Setup menu keys allow you to configure hardcopy output.
The Print key sends hardcopy data to the printer.

The Media Door on the right side of the front panel accesses the 3.5
inch disk drive.

Chapter 1

17



Table 1-1

Getting Started
Overview of the Front Panel

Front Panel Item Descriptions

Iltem

Description

9

The Data Entry Keys, which include the Up/Down arrow keys, RPG
(rotatable knob), and numeric keys, alow you to enter or change the
numeric value of an active function.

The Numeric Keys allows entry of exact values for many of the NFA
functions. To terminate a numeric, where no unit labels have been
presented, press the Enter key.

The RPG allows continuous change of functions such as marker
position.

The Up/Down arrow keys allow discrete increases or decreases of the
active function value.

10

Not currently supported.

11

PROBE POWER provides power for other accessories.

12

The <= Prev key accesses the previously selected menu.

13

NOISE SOURCE DRIVE OUTPUT +28V PULSED this connector
provides a 28 Vdc level to switch the noise source on. The noise
source is off when no voltage is applied.

14

Tab Keys are used to move between, table input fields, fields on
forms, and to move within the fields of the dialog box accessed by the
File menu keys.

15

INPUT 50Q Thisisthe input connector for the NFA.
N8972/3A models have a Type-N connector.
N8974/5A models have a precision 3.5 mm connector.

16

The Next Window key selects which graph or result
parameter is active.

Pressing Zoom key while in graph mode allows you to switch
between the dual-graph and single-graph display.

17

Pressthe Help key and then any front panel or menu key to get a short
description of the key function and the associated remote command.

18
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Front Panel Item Descriptions
[tem Description
18 The Smart Noise Source (SNS) connector provides the interface to
upload the ENR data, monitor the ambient temperature, and switch the
SNS off and on.
19 The q0n) key turnsthe NFA on, while the O (Standby) key switches
the NFA to standby.

Chapter 1
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Overview of the Rear Panel

Figure 1-2 Rear Panel Overview
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Table1-2 Rear Panel Item Descriptions
[tem Description
1 Power input istheinput for the AC line-power source.
2 Line Fuse. The fuseisremoved by twisting counterclockwise 1/4 turn.

Replace only with afuse of the same rating. See the label on the rear
panel and information in the Setup Guide.

3 Service Connector. The service connector isfor service use only.
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Rear Panel Item Descriptions

[tem Description

4 VGA OUTPUT drives an external VGA compatible monitor with a
signal that has 31.5 kHz horizontal, 60 Hz vertical synchronizing rate,
non-interlaced.

5 PARALLEL interface port isfor printing only.

6 RS-232 interface supports remote instrument operation.

7 Presel Tune Connector it isnot currently supported.

8 10 MHz REF IN accepts an external frequency source to provide the
10 MHz, —-15 to +10 dBm frequency reference used by the NFA.

9 10 MHz REF OUT provides a 10 MHz, 0 dBm minimum, timebase
reference signal.

10 LO GPIB port isfor the control of an external LO by the NFA.

11 MAIN GPIB interface port supports remote instrument operation.

12 AUX OUT (TTL) it isnot currently supported.

13 AUX IN (TTL) itis not currently supported.

14 Power On Selection selects an instrument power preference.

Chapter 1
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Overview of the Front Panel Keys

How the Front Panel Keys are Organized

The front panel keys are divided into four main groups:

* MEASURE keys, which are used to configure the measurement
parameters

e CONTROL keys, which are used to configure advanced measurement
parameters

* SYSTEM keys, which perform system-level operations

e DISPLAY keys, which adjust the display characteristics of the
measurement

Navigating Through the Menu System

Menu keys Pressing any of the grey front panel keysin the MEASURE, DISPLAY,
RESULT or SYSTEM key groupings accesses menus of functions that are
displayed along the right-hand side of the display. These keys are called
menu keys. See Figure 1-3.
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Overview of the Front Panel Keys

Figure 1-3 Menu Keys
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Action keys Pressing any of the white keys (Calibrate, Full Screen, Restart, Save
Trace and Print) invokes an action and these keys are called action keys.

To activate a To activate a menu key function, press the key immediately to the right of

menu key the screen menu key. The menu keys that are displayed depend on which

function front panel key is pressed and which menu level or pageis selected.

Selecting a Some menu keys have functions contained within them, for example, On

function within a and Off. To turn the function on, press the menu key so that Onis

menu key underlined. To turn the function off, press the menu key so that Off is
underlined.

For asummary of al front panel keys and their related menu keys, seethe
User’s Guide or the analyzer online help.
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Figure1-4

Getting Started
Display Annotation

Display Annotation

The display annotation, shown in Figure 1-4, is referenced by numbers.
Table 1-3 has a description and, where appropriate, afunction key indicating
which key activates the function related to the annotation.

Display Annotation
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Display Annotation

Each item is given a description and where applicable a function key
associated withit.

Table 1-3 Display annotation item descriptions
[tem Description
1 The active function area displays the label and value of the

currently active key.

2 The time and date display, controlled by the Time/Date menu
key, under the System key menus.

3 The marker numbers are displayed in this column, each row
displays the markersresults. It is controlled by the Marker and
the State menu keys.

4 The markers frequency is displayed in this column. It is
controlled by the Marker and the State menu keys.

5 The upper trace measurement result is displayed in this column.
Itiscontrolled by either the Result, Marker, State menu keys.

6 The lower trace measurement result is displayed in this column.
It is controlled by either the Result, Marker, State menu keys.

7 The GPIB annunciators RLTS.

8 The datainvalid indicator appears when ameasurement starts. It
disappears after a complete sweep.

9 The key menu title, thisis dependent on which key is selected.

10 The key menu.

11 The frequency span or stop frequency, controlled by the

Freq Span or Stop Freq key.

12 Displays the measurement correction state, uncorrected or
corrected. Controlled by the calibration state and the Corr key.

13 Displays the Loss Compensation status, On or Off. Controlled
by the Loss Comp key.

14 The number of points, controlled by the Points menu key.

Chapter 1 25
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Display Annotation

Table 1-3 Display annotation item descriptions
Item Description
15 Displaysthe value of attenuation being applied. The left itemis

the RF attenuator and the right item is the microwave attenuator.
On the N8972/3A only the RF attenuator statusis displayed.

16 The bandwidth, controlled by the Bandwidth menu key.
Thisisfixed at 4 MHz on the N8972A model.

17 The number of averages, controlled by the Averages menu key.

18 The center frequency or start frequency, controlled by the
Center Freq or Start Freq menu keys.

19 The Ty q temperature value, controlled by the Tcold menu key.

20 The display status line, displays instrument status and error
messages.

21 Thelower trace lower limit, controlled by the Lower Limit menu
key.

22 The lower trace unit of measurement on the Y-axis, controlled

by the Result key or Scale menu key.

23 The lower trace scale, controlled by the Scale/Div menu key.

24 The lower trace result type, controlled by the Result key.

25 Thelower trace upper limit, controlled by the Upper Limit menu
key.

26 The upper trace lower limit, controlled by the Lower Limit menu
key.

27 The upper trace unit of measurement on the Y-axis, controlled

by the Result key or Scale menu key.

28 The upper trace scale, controlled by the Scale/Div menu key.

29 The upper trace result type, controlled by the Result key.

30 The upper trace upper limit, controlled by the Upper Limit menu
key.
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Display Annotation

Table 1-3 Display annotation item descriptions
[tem Description
31 The limit line failureindicator.
Shownin The measurement mode status, controlled by the Meas Mode
Figure 1-5 key. Thisinformation is displayed by default. The status
disappears when the marker results are switched on.

Figure1-5 M easurement M ode Status

DUT Amplifi Do f

Basic Setup Measurement Mode

Using a Converter Measurement Mode
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Performing Common File Operations

This section covers;

» Formatting a diskette
» Saving afile

e Loading afile

* Renaming afile

e Copying afile

» Deeting afile

Formatting a Diskette

Theformat isMS-DOS. It is not necessary to format your diskette with the
NFA; pre-formatted disks can be used with the NFA.

Sep 1. Place the diskette you wish to format into the diskette drive (A:) of the NFA.

Sep 2. Access the file manager menu by pressing File key, File Manager. See
Figure 1-6.
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Performing Common File Operations

File Manager Menu

DUT Amplifier owncany OFf Copy»
Deleter

Renamer

Format»

Sep 3. Start the format process by pressing Format, then Enter.
Sep 4. PressEnter, asecond time to format the disk.
The format process takes approximately three minutes.

You are now ready to save filesto the disk.
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Saving a File

You can save files (ENR tables, states, traces, limits, frequency lists, loss
tables, or screens) to afloppy disk (2:), or theinternal drive (C:) of the
NFA.

Sep 1. To access the Save menu press File, Save.
Sep 2. Select the type of file you want to save.

For example, if you have limit line table data present and want to save it,
press Limits.

Sep 3. Select the limit line table file you wish to save (1, 2, 3 or 4).
For example, to savefile 2, press 2.
Sep 4. Enter afilename using the Alpha Editor menu keys.

Sep 5. Select the drive you wish to saveto by pressing Tab —, to moveto directory
and filelist, press Select.

NOTE If the correct driveisnot listedinthe path: field, highlight ». .~ at thetop
of the directory list. This enables you to move up adirectory. Press Select.
To highlight the desired drive, [-A-] or [-C-1) usethe arrow keysor the
RPG, press Select when highlighted.

Sep 6. PressEnter, to savethefile to the drive.
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Loading a File

You can load files (ENR tables, states, limits, frequency lists, or loss tables)
from afloppy disk (a:\), or theinternal drive (C:\).

NOTE

Not all the file types you save can be loaded back into the NFA. For
example, screen files and trace files. The tracefileisin aCSV (comma
separated value) format, designed for use with a PC.

Sep 1.
Sep 2.

Sep 3.

Sep 4.

Sep 5.

Sep 1.
Sep 2.

Sep 3.

Sep 4.

Sep 5.

To access the Load menu press File, Load.

Select the type of file you want to load (ENR tables, states, limits, frequency
lists, or losstables).

Select the drive where your file islocated by pressing Tab —. Use the RPG
to highlight [-C-] or [-A-1, then press Select.

Select thefile you want to load into the NFA by changing the highlighted file
with the up or down arrow keys to highlight the file name.

Press Enter to load the specified file.

Renaming a File
You can rename afileinthe [-C-] or [-A-] drive asfollows:
Press File, File Manager, Rename to access the Rename menu items.

Select the type of file you want to rename (ENR tables, states, traces, limits,
frequency lists, loss tables, or screens).

For example, if you are renaming a ENR tablefile, press ENR.

Select the drive where your file islocated, by pressing the Tab — key, press
Select. To change drive, use the arrow keysto highlight [-C-] or [-A-1T,
then press Select.

Select the file you want to rename by moving the cursor with the RPG or
arrow keysto highlight the file name.

Press Tab — to enter the Alpha Editor menu. File names are limited to eight
(8) characters.
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Press Enter and your fileis now renamed and visible within the directory
displayed on your NFA.
Copying a File

Thisalows you to copy afile to adifferent location on both the [-c-] and
[-A-] drive.

To access the Copy menu press File, File Manager, Copy.
Put a formatted floppy in the A: drive.

Select the type of file you want to copy (ENR tables, states, traces, limits,
frequency lists, loss tables or screens).

For example, if you are copying a State file, press State.

Select the drive where your fileislocated, by pressing Tab — to highlight
the From:Path: field. Select the drive, using the RPG or arrow keysto
highlight [-C-1 or [-A-], then press Select.

Select the file you wish to copy by highlighting the filename using the
front-panel knob or arrow keys.

Press Tab — to moveto the To: Path: field and select the drive where you
want to copy the file using the RPG or arrow keys then press Select.

NOTE

If the correct driveisnot listedinthe Path: field, highlight ». .” at thetop
of the directory list. This enables you to move up adirectory. Press Select,
to highlight the desired drive, ([-A-1 or [-C-]) then press Select again.

Sep 7.

Copy the file by pressing Enter.
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Deleting a File
Thisalowsyou to delete afilefromthe [-C-] or [-A-] drive.
To access the Delete menu press File, File Manager, Delete.

Select the type of file you want to delete (ENR tables, states, traces, limits,
frequency lists, loss tables, or screens).

Select the drive where the file you wish to delete is|located, by pressing Tab
— then using the RPG or arrow keysto highlight [-C-]1 or [-A-], then
press Select.

NOTE

If the correct driveisnot listed inthe Path: field, highlight . .~ at thetop
of the directory list. This enables you to move up adirectory. Press Select,
to highlight the desired drive, ([-A-1 or [-C-]) then press Select again.

Sep 4.

Sep 5.

Select the file you want to delete by moving the cursor with the RPG or
arrow keys to highlight the file name.

Press Enter and your file is now deleted and is no longer visible in the
directory displayed on your NFA.
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Working with Tables

The Frequency List, ENR Table, Limit Line Editor, and L oss Compensation
Tables use table forms. The following is an overview of how to use the
featuresin these tables.

Table1-4 Using Tables

To... Usethe...

Move the highlight bar within the table | Tab keys

Bring the highlight bar to thetop of the | Home key

table

Clear thetable of al entries Clear Table menu key
Delete asingle row entry Delete Row menu key
Add anew entry Add menu key

Move the highlight bar up one row Row Up menu key

Move the highlight bar down one row Row Down menu key

Move the table up a page block Page Up menu key

Move the table down a page block Page Down menu key

Enter avalue Numerical key pad

Terminate avalue The unit values presented by the
menu keys?

Connect Limit Line points The arrow keys or the RPG

a. A limit line value is aunitless value and it depends on the
result’s scale unit used.
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Making Basic M easurements

This chapter describes how to make basic noise figure measurements using
your NFA and also covers the most common measurement related tasks.
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What You will Find in this Chapter

This chapter covers.

Entering Excess Noise Ratio (ENR) Data
Setting the Measurement Frequencies
Setting the Bandwidth and Averaging
Cdlibrating the Analyzer

Displaying the Measurement Results
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Entering Excess Noise Ratio (ENR) Data

You can enter ENR data for the noise source you are using as a table of
values or as asingle spot value. The table of values are used for
measurements at several frequencies. The single spot valueis used for single
frequency measurements or it is applied across the whole frequency
measurement range.

There are two types of noise source. Thefirst type, for example,

Agilent 346B, anormal noise source. These need their ENR data to be
entered manually either using the ENR data stored previously on a diskette
or by using the keypad. The other type, for example, Agilent N4OOOA, a
Smart Noise Source (SNS), can upload the data automatically or when
requested.

Selecting a Common ENR Table

To use the same ENR table for calibration and measurement, press the
Common Table menu key to select Common Table(On); see Figure 2-1.

Thisisthe default setting. In this mode the Cal Table is not accessible.

Menu Keys showing Common ENR Table On

Common Table
Off On

ENR Table»
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To use different ENR tables for calibration and measurement, press the
Common Table menu key to select Common Table(Off); see Figure 2-2.

In this mode, the Cal Table menu key isaccessible. Thisisthe ENR table of
the noise source used to calibrate the NFA. The Meas Table is used to make
measurements. In Common Table(Off) mode the ENR Table isthe

Meas Table inthe Common Table(On) mode.

Figure 2-2 Menu K eys showing Common ENR Table Off
Common Table
0ff On
Meas Table»
Cal Table»
NOTE If you are using an SNS when Common Table(Off) is set, you need to set

Auto Load ENR(Off) and use the Fill Table From SNS menu key. See
“Loading the SNS ENR data to the Measurement or Calibration Table.” on

page 46.

Entering ENR Table Data for Normal Noise Sour ces

You can enter ENR datain the form of an ENR table in four ways:

» manually by inputting the required frequencies and corresponding ENR
values

» loading the ENR data from a diskette, on which the data has been
previously stored

» loading the ENR data from the internal memory, where the data has been
previoudly stored

» loading the ENR data over GPIB, see the Programmer’s Reference for
more details
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To enter ENR table data manually
Press the ENR key, and the ENR Table menu key.

An Empty ENR Table

ENR Table

Noise Source Serial Number

Noise Source Model ID

Frequency

ENR Value

Use 'File' key to Load or Save a table.

I ENR Table

Edit Table»
Serial Number»

ID»

Fill Table
Fram SN

Optional Step

Pressthe Serial Number menu key and enter the noise source serial number

using the numeric keys and the Alpha Editor.

Optional Sep

Press the ID menu key and enter the noise source model number using the
numeric keys and the Alpha Editor.

Press the Edit Table menu key to enter the noise source ENR values.

Enter the frequency value in the table using the numeric keys. Terminate it
using the unit menu keys.
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Sep 6. Pressthe Tab —> key to move the highlight to the ENR Value column and
enter the corresponding ENR value of the ENR list.

When terminating the ENR value you can use either dB, K, C, or F menu
keys. TheK, C, or F entry is converted to appear in the table as dB.

Sep 7. Pressthe Tab —> key to move the highlight to the Frequency column and
enter the next frequency value on the ENR list.

Sep 8. Repeat steps 5 to 7 until al the frequency and ENR values you need are
entered.

Sep 9. After completing the ENR table entries, press the Prev key or ENR key to
return to the ENR menu.

Sep 10. Optional Step

Once you have completed entering the ENR data, save the ENR table using
the File key.

NOTE ENR table data survives a power cycle and preset (except
Restore Sys Defaults). You only need to save the ENR data to save you
from entering the data again.
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Figure 2-4
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Sep 4.
Sep 5.
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A Typical ENR Table after data entry

= Agilent | Edit Table
ENR Value 15.400 dB

Row Up
ENR Table

Frequency ENR Yalue Row Down
Noise Source Serial Number %%g%%%%%% m; ggg% SE
[3318A14197 1.00000000 GHz | 15.360 dB Page Up

2.00000000 GHz | 15.120 dB
300000000 GHz | 14.970 dB

Noise Source Model ID 400000000 GHz || 14.91@ dB Page Down
5.00000000 GHz | 14.850 dB

3468 6.00000000 GHz | 14.900 dB  —
7.00000000 GHz | 14.860 dB Add

5.00000P00 GHz | 14.390 dB
9.00000000 GHz | 15.910 dB
10.0000000 GHz | 15.110 dB
11.0000000 GHz | 15.260 dB Delete Row
12.0000000 GHz | 15.400 dB P
13.0000000 GHz | 15.440 dB

Use 'File' key to Load or Save a table.

Clear Table

Toload ENR data from memory

If the ENR fileis on diskette, insert the diskette into the floppy drive of the
NFA.

Press the File key.

Press the Load menu key to access the file system.
Press the ENR menu key.

Press either the Meas Table or Cal Table menu key.

A list of availablefilesonthe [-A-] or [-C-] driveisdisplayed. Usethe
arrow keys to access the appropriate file.

Pressthe Enter key.
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Saving an ENR Table

You can save an ENR table to the NFA's internal memory or to floppy disk
asfollows:

Sep 1. PresstheFile key.
Sep 2. Pressthe Save menu key.
Sep 3. Pressthe ENR menu key.

Sep 4. Presseither the Meas Table or Cal Table menu key. Also, if you are using an
SNS, an SNS menu key is available to select.

The Alpha Editor now appears, alowing you to create a name for thefile.
Sep 5. Input the name of the ENR table.

Sep 6. Select using the arrow keys whether you want to save thefilesto the [-A-]
or [-C-] drive.

Sep 7. PressEnter to savethefile.
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Entering a Spot ENR Value

To enter a Spot ENR value:
Sep 1. Pressthe ENR key, then the Spot menu key.
Sep 2. Pressthe Spot ENR menu key.

Sep 3. Enter an ENR value using the numeric keys and terminate it using the unit
termination menu keys. The default valueis 15.20 dB.

NOTE If you are using a noise source with a calibrated ENR list and the frequency
you want to measure is not alisted ENR value, then you need to interpolate
the ENR list to an appropriate value.

To Enable Spot ENR Mode
Sep 1. Pressthe ENR key, and select the ENR Mode(Spot) menu key.
Sep 2. Pressthe Spot menu key, and select the Spot Mode(ENR) menu key.
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Entering a Spot T, Value
To enter a Spot Ty, value:

Sep 1. Pressthe ENR key, then the Spot menu key.
Sep 2. Pressthe Spot Thot menu key.

Sep 3. Enter a Ty value using the numeric keys and terminate it using the unit
termination menu keys. The default value is 9892.80 K.

To Enable Spot Thot M ode
Sep 1. Pressthe ENR key, and select the ENR Mode(Spot) menu key.
Sep 2. Pressthe Spot menu key, and select the Spot Mode(Thot) menu key.
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Using a Smart Noise Source

NOTE

If thereisan SNS connected to the NFA's Smart Noise Source port, the NFA,
by default, selectsthe SNS asits noise source. If an SNSis not connected the
NFA uses the normal noise source.

Sep 1.
Sep 2.
Sep 3.

Selecting the Source Preference

If noise sources are connected to both ports you need to select a preference
either Preference(Normal) or Preference(SNS). The default setting is
Preference(SNS).

To select a noise source preference:
Press the ENR key.
Pressthe SNS Setup menu key.

Press the Preference menu key changing it from the default
Preference(SNS) to Preference(Normal).

L oading the SNS ENR data to the Common Table.

You can enable the NFA to automatically upload the ENR datato the
Common Table. To enable automatic loading on power up or the connection
of the SNSto the NFA's Smart Noise Source port, set Auto Load ENR(On).
This enables the ENR data to load into the Common Table automatically. If
you do not want to automatically upload the ENR datainto the Common
Table, press Auto Load ENR(Off).

If you have selected Auto Load ENR(Off), you can use the

Fill Table From SNS menu key to upload the ENR datafrom the SNS. The
Fill Table From SNS menu key isfound under the ENR Table menu key. It
isonly active when an SNSis connected. This allows you to choose when to
upload the ENR data to the ENR Table.

CAUTION

Do not disconnect the noise source from the NFA port while the datais being
transferred.
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Loading the SNS ENR data to the Measurement or Calibration Table.

NOTE When an SNSis connected and Auto Load ENR(On) enabled, the
Common Table(On) is set automatically. Hence, the SNS ENR datais
loaded into the common ENR table.

You can use the Fill Table From SNS menu key to upload the ENR data
from the SNS. Thisalows you to choose between Meas Table or Cal Table,
as the destination for the ENR data.

Sep 1. Pressthe ENR key.

Sep 2. Pressthe SNS Setup menu key.

Step 3. Pressthe Auto Load ENR menu key setting it to Auto Load ENR(Off).
Sep 4. Pressthe Common Table menu key setting it to Common Table(Off).
Sep 5. Pressthe Meas Table or Cal Table menu key.

Sep 6. PresstheFill Table From SNS menu key and wait until all the datais
uploaded.

CAUTION Do not disconnect the noise source from the NFA port while the datais being
transferred.
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Setting the T o4 value

When making measurements in different ambient temperature conditions
you can change the T4 value.

The default temperature valueis set at 296.50K. The Ty q menu key isset to
Tcold(Default) to confirm this default temperature.

There are three methods of changing the T4 value. These are dependant on
the type of noise source you are using.

» Thefirst method is applicable when using either type of noise source and
allows you to enter a T q value manually. This method is explained in

“Changing the User Tcold value manually” on page 47.

» The second method is applicable when using the SNS noise source and it
uploads the value automatically and updates the value after every sweep.
This method is explained in “ Setting the SNS Tcold val ue to Update
Automatically” on page 48.

» Thethird method is applicable when using the SNS where you can set the
value to be updated as you need. Thismethod isexplained in “ Setting the
SNS User Tcold value” on page 49.

Changing the User T4 value manually
To change the User T4 value:

Press the ENR key.

Pressthe Tcold menu key.

NOTE

When using an SNS, the SNS Tcold menu key must set to SNS Tcold (Off)
for this feature to work.

Sep 3.

Pressthe User Tcold menu key setting it from the default User Tcold(Off)
to User Tcold(On).

The Tcold menu key, under the ENR menu keys, is now set to Tcold(User)
to confirm you are using this temperature mode.
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Press the User Value menu key.

Enter a T4 Value using the numeric keys and terminate it using the unit
termination menu keys.

The unit termination menu keys arein K (Kelvin), C (Celsius) or
F (Fahrenheit).

Setting the SNS T 4 value to Update Automatically

Thisfeatureis only available when an SNSis connected to the NFA.
To set the SNS T4 Value:

Pressthe ENR key.
Pressthe Tcold menu key.
Press the SNS Tcold menu key, if required, setting it to SNS Tcold(On).

The Tcold menu key, under the ENR menu keys, is now set to Tcold(Auto)
to confirm you are using this temperature mode.
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Setting the SNS User T4 Value

This feature only works when an SNSis connected to the NFA.
To change the User T4 value:
Press the ENR key.

Press the Tcold menu key.

NOTE

When using an SNS, SNS Tcold must set to SNS Tcold(Off) for this feature
to work.

Sep 3.

Sep 4.

Press the User Tcold menu key changing it from the default
User Tcold(Off) to User Tcold(On).

Press the User Tcold From SNS menu key.

The NFA uploadsthe Tcold value from the SNS and displaysthe valuein the
User Value menu key.

The Tcold menu key, under the ENR menu keys, is now set to Tcold(User)
to confirm you are using this temperature mode.
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Setting the M easurement Frequencies
Three frequency modes are available:

» Sweep — the measurement frequencies are obtained from the start and
stop (or equivaent center and span) frequencies and the number of
measurement points.

e List — the measurement frequencies are obtained from the frequency list
entries.

* Fixed — where the measurement frequency is taken at asingle fixed
frequency.

Selecting Sweep Frequency M ode

CAUTION

The N8974A and N8975A NFA models have a mechanical switch fitted to
alow them to switch between the RF frequency range and the microwave
frequency range. If the frequency range you are working in crosses the

3.0 GHz point, the mechanical switch operates. The mechanical switch hasa
limited number of cycles over whichitisreliable.

Switching over the 3.0 GHz switch should be limited where possible.

NOTE

You can press Full Span at anytime to return the frequency range to the
specific NFA model’sfull range setting. If you do this after acalibration and
the calibration has been made over a narrower frequency range, the
calibrationisinvalid.

Sep 1.
Sep 2.

Sep 3.

Press the Frequency/Points key.

Press the Freq Mode menu key to select frequency modeto
Freq Mode(Sweep).

Set the frequency range by either entering the Start Freq and Stop Freq
frequencies, or the Center Freq and the Freq Span.
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Sep 4. Pressthe More 1 of 2, Points menu keys.

Sep 5. Enter the number of measurement points using the numeric keys. Press the
Enter key to terminate.

Selecting List Frequency Mode
To set the NFA to use the datain the frequency list table:
Sep 1. Pressthe Frequency/Points, Freq Mode menu keys.
Sep 2. Pressthe Fixed menu key to set the frequency mode to Freq Mode(List).
You can create a frequency list in the following ways:
» Manually, by specifying each individual point.

» From the swept points, by specifying the measurement frequency range
and setting the NFA to generate equally spaced points within that range,
using the Fill menu key.

» Loading alist from the internal memory or diskette, where the data has
been previoudly stored.

» Loading alist over GPIB; see the Programmer’s Reference if you want
to use this method.

To Createa Frequency List Manually
Sep 1. Pressthe Frequency/Points key and press the More 1 of 2 menu key.
Sep 2. Pressthe Freq List menu key.
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Figure 2-5 An Empty Frequency List
- Agilent Im
] Row Up
Freqguency List
Frequency Row Down
o Page Up
EE Page Down
o Add
- Delete Row
— More
Use 'File' key to Load or Save a table. 10f2"

Sep 3. Pressthe More 1 of 2, Clear Table menu keys.

Sep 4. Enter the frequency value you want using the numeric keys. Terminate it
using the unit menu keys which are presented to you.

Sep 5. Pressthe Tab —> key or Row Down menu key.

Enter the next frequency value by using the numeric key pad and the unit
termination keys.

Sep 6. Repeat step 5 until your list is complete.

Sep 7. Savethe Frequency List to the NFA internal memory or to a diskette if
required using the File key. See “ Saving a File” on page 30 for an
explanation of this.

NOTE If you do not save the frequency list, you may lose the data. This depends on

your Power On/Preset condition.
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Creating a Frequency List from Swept Points

You can create a frequency list from the swept mode frequency and points
data.

To set the NFA to use the swept mode data:

Press the Frequency/Points, More 1 of 2 menu keys.

Pressthe Freq List, More 1 of 2 menu keys.

Pressing the Fill menu key.

This clears the current frequency list and fills the list with the frequencies
generated by the sweep frequency mode.

Selecting Fixed Frequency Mode

The fixed frequency mode is used when you want to make a measurement at
asingle frequency.

To set afixed frequency:

Press the Frequency/Points, Freq Mode menu keys.

Press the Fixed menu key to set the frequency mode to Freq Mode(Fixed).
The Fixed Freqg menu key is now available.

Press the Fixed Freq menu key and enter the frequency value using the
numeric keys and the unit termination menu keys.
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Setting the Bandwidth and Averaging

Selecting a Bandwidth Value
Pressthe Averaging/Bandwidth key.
The current bandwidth is shown on the Bandwidth menu key.

Press the Bandwidth menu key and select the bandwidth you want from the
list of available options.

NOTE

On the N8972A model, the bandwidth menu key is unavailable. The
bandwidth isfixed at 4AMHz.

Enabling
averaging

Sep 1.
Sep 2.

Setting Averaging

Increased averaging reduces jitter and provides more accurate measurement
results. However, the measurement speed is sacrificed.

Averaging can be enabled by setting the Averaging(On). To disable
averaging set Averaging(Off)

Setting the Number of Averages

Pressthe Averaging/Bandwidth key, and then the Averages menu key.

Enter the numeric value you want using the numeric key pad. Terminate it
with the Enter key.

Selecting the Averaging M ode

Averaging Mode can be set to Average Mode(Point) or
Average Mode(Sweep).
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Calibrating the Analyzer

To compensate for the noise contribution of the NFA, the associated cabling,
and so forth in the measurement path, a calibration is necessary.

To perform calibration you need to enter the ENR values and set up the
frequency range, number of measurement points, the bandwidth, the
averaging, and measurement mode to be used during the measurement. For
more details on calibration, such as when to perform calibration and when
calibration isinvalidated and so forth, see the User’s Guide.

To perform acalibration

Verify that the correct ENR table isloaded in the NFA, or input the ENR
values of the noise source into the NFA.

See “Entering Excess Noise Ratio (ENR) Data” on page 37 for more details.

Configure the measurement parameters (frequency range, number of points,
bandwidth, averages, and measurement mode) you want to use for the
measurement.

Connect the noise source output directly to the NFA input.

NOTE

If you are following this procedure using an N8974A or an N8975A models
care needs to be taken when connecting the precision 3.5 mm connector by
applying the correct torque. For an explanation of the connectors and
guidance on the correct torque val ues, see the Performance Verification and
Calibration Guide.
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Figure 2-6 NFA Calibration with Normal Noise Source

Noise Source

NOTE You may need to use connector adaptors to connect the noise source output
to the NFA input during calibration. The connectors you use need to be
included in the measurement. If you remove the connectors from the
measurement you need to apply Loss Compensation to compensate for any
loss caused by the connectors removal. See “Using Loss Compensation” on
page 81 for an explanation of this.

Sep 4. If required select an input attenuator range by pressing the Corr key and the
Input Cal menu key to set the minimum and maximum input attenuation.

See " Selecting the RF Input Attenuation Range” on page 57 for more details
on input attenuation.

Sep 5. Pressthe Calibrate key twice to initiate the calibration.
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Selecting the I nput Attenuation Range

Selecting the RF Input Attenuation Range

When measuring a high-gain device you may need to increase the input
attenuation. If you do not know the gain of the DUT, you can perform
calibration using the default range, note what error codes are presented and
then calibrate again using increased attenuation value. The attenuation value
isindicated on the display. If the NFA continuesto display error codes, there
isaneed to add external attenuator pads and correct for this attenuation
using the L oss Compensation feature. For an explanation of how to use the
feature, see “Using Loss Compensation” on page 81.

If an error message occurs while calibrating, you need to recalibrate. For a
complete list of error codes see the User’s Guide.

To select the RF input attenuation:
Pressthe Corr (Corrected) key.
Press the Input Cal menu key and select the attenuation range you want

Set the attenuator range using the Min RF Atten and Max RF Atten menu
keys, and select the attenuation values you want from the list.

Selecting Microwave I nput Attenuation Range

The N8974A and N8975A models have a microwave frequency range.
When working in the microwave frequency range of 3.0 GHz to 26.5 GHz,
the NFA has adefault input attenuation for calibration of 0 dB. Unlike the
RF attenuators, the microwave attenuators cannot autorange. Therefore there
isarisk of overdriving the instrument. In most cases O dB attenuation is
adequate. A guideto the input powersthat each range can handle can be seen
in Table 2-1.

Table 2-1 Power Detection and Ranging

Attenuation | Maximum Input DUT Parameters
Power

o0dB -30dBm Combined NF and Gain of DUT <25 dB
over full bandwidth
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Table 2-1 Power Detection and Ranging
Attenuation | Maximum Input DUT Parameters
Power
15dB —20dBm Combined NF and Gain of DUT
> 25 dB and <35 dB over full bandwidth
30dB -10dBm Combined NF and Gain of DUT
>35 dB and <45 dB over full bandwidth

To select the microwave input attenuation:

Sep 1. Pressthe Corr (Corrected) key.

Sep 2. Pressthe Input Cal menu key and select the attenuation range you want

Sep 3. Set the attenuator range using the Min mW Atten and Max mW Atten menu
keys, and select the attenuation values you want from the list.

Setting the Microwave I nput Attenuation after a Calibration

The microwave attenuators cannot autorange. Hence, when making a
microwave measurement you must manually set the microwave input
attenuation to avoid overdriving the NFA. To set the microwave input

attenuation:

Sep 1. Pressthe Sweep key.

Sep 2. Pressthe Manual Meas, More 1 of 2 menu key.

Sep 3. Pressthe Fixed mW Att menu key and select the attenuation range you

want.

Sep 4. Pressthe More 2 of 2 menu key.

Sep 5. Pressthe RF/mW Atten menu key to enable RF/mW Atten(Fixed).

NOTE

If you want to set the RF input attenuation, “ Setting the Microwave Input
Attenuation after a Calibration” procedure can be applied to RF input
attenuation. The procedure is similar except you need to substitute

Fixed RF Att in Step 3.
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Displaying the M easurement Results

Thefollowing display format features are available:
» Graph, Table or Meter mode display

» Singleor dual-graph display allowing any two available result typesto be
displayed simultaneously

» Zoom to display only one result graph on the display

» Combine option to display two result types on the same graph
» Markersfor searching the trace

» Display an active trace, amemory trace, or both

» Savethe current active trace data to memory

» Switch the graticule on or off

» Switch display annotation on or off

NOTE

If the NFA's display has been previously disabled in Remote mode, you need
to press the System (LOCAL) key to activate the display.

Sep 1.
Sep 2.

Selecting the Display Format

You can display the measurement resultsin either:
» Graph format

» Tableformat

* Meter format

To set the display format:

Press the Format key.

Press the Format menu key and select the Graph, Table or Meter menu key
to select the display mode you want.
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Changing the
Active Graph
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Navigating Around the Display

The active graph is highlighted by a green border. Noise Figure is the active
graph by default.

Dual-graph display

| Frequency

Freq Mode,

Sweep

DUT Amplifier

Start Freq
1.00000088 GHz

Stop Freq
2.00000008 GHz

Center Freq
1.50000008 GHz

-1.664

Freq Span
1.00000088 GHz

Fixed Freq
14.7508088 GHz

Hore’
lof2

—
To change the active graph, press the key below the display. This
key allows you to set the upper or lower graph as the active graph.

NOTE

When in table or meter format the key changes the active parameter.

Viewing the Full
Screen

You canfill the entire display and remove the menu keys, the active function
areaannotation, and the display status line annotation from the display. Press
the Full Screen key to view the full screen. Pressing the Full Screen key
again returnsit to the previous display.

NOTE

The Full Screen key also functionsin table or meter format.
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Selecting Result Typesto Display

NOTE

You cannot display the same result type in both graphs. If you attempt this,
an error message Each result type selected must differ from
all others isdisplayed in the status line.

Sep 1.
Sep 2.
Sep 3.
Sep 4.

To specify which measurement results are displayed

Select which measurement result is active using the key.

Press the Result key and select the result type that you want to display.

Pressthe key to make the other measurement result active.

Press the Result key and select the result type you want to display.

NOTE

When you press the Scale key, the active measurement result’s scale menu
keys are shown.

Chapter 2 61



Making Basic Measurements
Displaying the Measurement Results

Graphical Features
Viewing a single graph

Whilein graph format mode, you can pressthe key located below the
display and the active graph fills the display as a single graph, as shown in
Figure 2-8. Pressing the key again returns the display to dual-graph.

Figure 2-8 Displaying a single graph
WUT Amplifie O Autoscale

Units
dB Linear

Upper Limit
40,008

Lower Limit
-10.668

Ref Level
15.000

Display Ref
f On

-16.68
o ) . — - Scale/Div
o ., ;: ] 5.000

NOTE When in single graph mode, pressing the key displays the other
single graph.
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Combining two graphs on the same graph

The default setting is Combined (Off) and the graphs are not combined.

NOTE When combining two graphs the Y-scale result limits are not re-scaled and
both graphs have their own Y-scale result limits.

To combine the two graphs:
Sep 1. Pressthe Format key and ensure Format(Graph) is selected.

Sep 2. Pressthe Combined(On) menu key to combine the two currently displayed
graphs on the same graph.

Figure 2-9 Typical display with two traces combined on the same graph

5 Agilent | Format

DUT Amplifier w5 Downcony Off

Format,
Graph

Combined
0ff Oni

Trace,
Data

Data ->
Memory

Graticule

0ff On

Annotation
0ff Oni
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Displaying the Current Data Trace and the Recalled Memory Trace

When atrace finishes its first complete sweep, the Data -> Memory menu
key becomes active.

To save atrace to memory, press the Data -> Memory menu key. After
pressing the Data -> Memory menu key, the Trace menu key becomes
active.

To view the saved trace, pressthe Trace menu key, followed by the Memory
menu key. The memory trace is presented in the display.

To view both the saved trace and the current active trace, pressthe Trace
menu key, followed by the Data & Memory menu key.

To view the current data trace only, press the Trace menu key, followed by
the Data menu key. Thisisthe default setting.

NOTE

Pressing Autoscale does not re-scale a memory trace.
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Turning the Graticule On and Off
To turn the graticule on or off:
Press the Format key.

Press the Graticule menu key to select the Graticule(Off) Of Graticule(On) as
required.

Turning the Display Annotation On or Off
To turn the annotation on or off:
Press the Format key.

Press the Annotation menu key to select Annotation(Off) or
Annotation(On) as required.

NOTE When Annotation(Off) is selected and limit lines are set to Test(On) the
limit line failure indicator is disabled.
Setting the Scaling
You can set the result’s scale parameters in the active graph. To set the scale,
press the Scale key.

NOTE To change the active graph, press the Result key and select another

measurement parameter’s menu key. Press the Scale key to set the scale of
the measurement parameter.
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Figure 2-10 Typical Noise Figure Displayed on a Graph

Autoscale

10.88 Units
dB Linear

Upper Limit
16,008

Lower Limit
[.668

Ref Level
4,000

Display Ref
f On

Scale/Div
1.6608

You can set the scale for the measurement parameter or pressthe Autoscale
menu key. Pressing Autoscale selects the optimum values for Upper Limit,
Lower Limit, and Scale/Div.

NOTE If limit lines are set to Display(On), and Autoscale is pressed or the scaleis
changed, the limit lines may no longer appear in the display.

NOTE If amemory trace is set to display, and Autoscale is pressed or the scaleis
changed, the memory trace may no longer appear in the display.
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Setting the Reference L evel

NOTE The reference level minimum and maximum limits are restricted to the
values of the upper and lower scale settings.

NOTE The reference level isonly visible when the Display Ref(On) is enabled.

Sep 1. Pressthe Display Ref menu key if you want the reference level displayedin
the active graph. The default setting is Display Ref(Off). Set the
Display Ref(On) to switch the reference level on.

Sep 2. Pressthe Ref Level menu key. Change the reference level value using the
RPG or the numeric keys. Valuesthat are entered using the numeric keys are
terminated using the Enter key.
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Working with Markers

NOTE

The marker functions only apply when you are working in graph format.

Sep 1.
Sep 2.
Sep 3.

Figure2-11

The NFA has four markers, Marker(1), Marker(2), Marker(3), and
Marker(4). The markers are coupled to both the lower graph trace and upper
graph trace.

Selecting Markers

To select amarker:

Press the Marker key.

Press the Marker menu key to select the marker of interest.

Press the State menu key and press the Normal menu key to highlight it.

A Normal State Marker

- Agilent | Marker
Marker Frequency 1.505000000 G ark
= arker

Mirl 1.5851 GH=z : ] 28.449 dB 1 2 3 4

State,
Mormal

Band Pair|

ef Mormal

Trace
ata Memory

Searchr

Markers
All Off

Turn the RPG to place the markers at the point on the trace you want to
measure or use the numeric keys to enter the frequency of interest..
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To turn an active
marker off

To change the
active marker

Figure 2-12

To Switch all the
Markers Off

Making Basic Measurements
Displaying the Measurement Results

To turn an active marker off, press the State menu key and press the Off
menu key. This aso removes the marker annotation above the graph and the
marker frequency from active function area.

The default active marker setting is Marker(1). To change the active marker,
press the Marker menu key. This moves the active marker from Marker(1) to
Marker(2). Pressit again and it moves the active marker from Marker(2) to
Marker(3). This processis repeated until it returnsto the Marker(1).

Four Normal Sate Markers

- Agient | Marker
Marker Frequency 1.8801082040 GHz ark
arker

> 3 4

State,
Mormal

Band Pair|

Ref Mormal

Trace
Data Memory

Searchr

Markers
All Off

To switch all the markers off press Markers All Off. This turns off all the
markers and associated annotation.

Chapter 2 69



To use Delta

Markers

Sep 1.
Sep 2.
Sep 3.

To use Band Pair

Markers

Sep 1.
Sep 2.
Sep 3.

Sep 4.

Sep 5.
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Changing the Marker States

The State(Delta) menu key places areference marker at the current position
of the active marker. The delta markers enable you to measure the difference
between the reference marker and the delta marker position on the trace.

To activate a Delta marker:
Press the Marker key.
Press the Marker menu key to select the marker of interest.

Press the State menu key and press the Delta menu key to highlight it. Use
the RPG to move the Delta marker from the reference. The annotation
displays the difference.

The State(Band Pair) menu key places two markers allowing you to choose
to move either the normal marker or the reference marker. Thisfeatureis
similar to the State(Delta) except you can choose to move either marker.
The position of the reference marker remains fixed until Band Pair(Normal)
menu key is pressed and the active marker becomes the fixed marker. This
can be dtered by pressing the Band Pair(Ref) menu key to enable the
reference marker as the active marker.

To activate the Band Pair markers:
Press the Marker key.
Press the Marker menu key to select the marker of interest.

Press the State menu key and press the State(Band Pair) menu key to
highlight it.

Use the RPG to move the active marker from the reference. The annotation
displays the difference between the reference and the normal markers
position.

Pressing the Band Pair menu key setsthe Band Pair(Normal) as the fixed
marker allowing you to move the reference marker. Pressing the Band Pair
menu key again setsthe Band Pair(Ref) asthe fixed marker allowing you to
move the normal marker.
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Figure2-13 Band Pair with Normal Marker Enabled

| Marker
Marker Frequency 1.748826523 GHz
Marker

1 2 3 4

H.461 dB

State,
Band Pair

Band Pair

Ref Mormal

Trace
Data Memory

Searchr

Markers
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Marking Memory Traces
To place a marker on the recalled memory trace:
Sep 1. Enable the Trace(Memory) menu key.
Sep 2. Set the marker you want to use to Normal, Delta, or Band Pair.

The marker is placed on the memory trace. If Trace(Data&Memory) on the
format menu is enabled, switching between Trace(Data) and
Trace(Memory) switches the marker between the traces.

NOTE If amarker is set to Trace(Memory) and the Memory trace is not displayed,
the marker and its annotation are not displayed.
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Searching with Markers

NOTE If you are searching continuously the markers have additional annotation
which identifies which marker is the minimum and the maximum. The
annotation is“v” aminimum, “A” amaximum. If you change the active
graph the annotation remains on the original graph.

Searching for You need to have activated aNormal or Delta marker state to perform a
Min or Max point minimum or maximum search.

Figure2-14 Typical Trace showing Maximum Point Found
45 Agilent | Search
Marker Frequency 1.123743841

—————— - — Marker
Mkrl 1.8714 GHz 3 ] 2 B l 2 3 4
Search Type,
Max
Continuous
0ff On
Find

To search for the maximum point:
Sep 1. Pressthe Search menu key.
Sep 2. Pressthe Search Type menu key to select the Search Type(Max).
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Sep 3. Pressthe Find menu key.

If you want to continuously find the maximum point on the trace, select
Continuous(On).

Searching for You need to have activated a marker state to Band Pair to perform a Peak to
Peak to Peak Peak search.
points

Figure 2-15 Peak to Peak Found

= el | Search
Reference Marker Frequency 1.362068965 GHz ark
arker

1.898 dB —4.047 o AR R

Search Type,
Pk—Pk

Continuous
tf On

Find

Sep 1. Pressthe Search menu key.
Sep 2. Pressthe Search Type menu key to select Pk-Pk.
Sep 3. Pressthe Find menu key.

If you want to continuously find the maximum and minimum points on the
trace, select Continuous(On).
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Indicating an Invalid Result

Several invalid result conditions may exist simultaneously. These conditions
areranked in order of severity and only the most severe condition present is

displayed.
The ranking order is:
Table 2-2 Ranking Order of Invalid Result Conditions

Ranking Order | Invalid Result Condition Marker Indicator
1 Hot power < cold power ==
2 Corrected calculation not possible “XX”
3 Measurement result calculation invalid

The ranked order 2 only occursif a corrected measurement is requested and
either:

* Theinput range used at this measurement point is not calibrated.

» Theinput rangeis calibrated, but the calibration dataisinvalid at this
point.

See the User’s Guide for further information about the over and under range
indicators.
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Advanced Features

This chapter describes how to use the Limit Lines and Loss Compensation
features on your Noise Figure Analyzer. It also covers how to make manual
measurements.
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What You will Find in this Chapter

This chapter covers:

» Setting up Limit Lines and using them for pass/fail testing of the
measurements.

» Using Loss Compensation and using thisto correct for system lossesin
cabling, switches, or connectors and so forth. Also, the use of S2Pfile
formats to create Loss Compensation Tables.

* Making Manual Measurements.
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Limit Line

Setting the Type
of Limit Line

Enabling Testing
against a Limit
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Setting up Limit Lines

The NFA features four independent Limit Lines. The Limit Line(1>) and
Limit Line(2>) are applied to the upper graph, and Limit Line(3fl) and
Limit Line(4fl) are associated with the lower graph.

The default limit line setting is Limit(1>). To change the active indicator,
press the Limit Line menu key. This moves the active indicator from
Limit Line(1>) to Limit Line(2>), pressit again and it moves the active
indicator from Limit Line(2>) to Limit Line(3fl). This processis repeated
until it returnsto the Limit Line(1>).

To set thelimit line type, choose Type(Upper) if you want it to be above the
trace or Type(Lower) if you want it to be below the trace. Each of the four
limit line needs to be set up separately.

To set the testing of the trace against the limit line, choose Test(On) if you
want the result reported or Test(Off) if you do not want the result reported.
Each of the four limit lines need to be set up separately.

NOTE After afailurethe LIMITS FAIL: indicator remains displayed until you
either switch Test(Off), change the limit line type, or press Restart.

Figure 3-1 Limit Fail Indicator

=2 Agilent

AlL: )
: ’ \ Limit Fail Indicator

To Display a To display the limit line on the graph, choose Display(On). To not display
Limit Line the limit line on the graph, choose Display(Off). Each of the four limit line
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Advanced Features
Setting up Limit Lines

needs to be set up separately.

To switch all the Limit Lines off, press Limit Lines All Off. This
simultaneously switches off al Limit Lines, regardless of what graph or
trace they are associated with and setting both Test(Off) and Display (Off).

NOTE

When alimit line is switched off the limit line datais not affected.

Sep 1.
Sep 2.
Sep 3.
Sep 4.

Sep 5.
Sep 6.

CreatingaLimit Line

Pressthe Limit Lines key and select the limit line you want to create.
Press the Editor menu key.

Enter the first Frequency value. Pressthe Tab key.

Enter the first Limit or Y-axis unit value. Press the Tab key.

For alimit line value to be useful, it should be derived from the scale values
you are using to display the trace.

Press the arrow key to change Connected to either Yes or No.
Repeat this process until the limit line is defined.

Thelimit line is now defined. Pressthe Prev key or Limit Line key to return
to the limit line menu. When saving alimit line table you need to specify
which limit line number. See " Saving a File” on page 30.

NOTE

You can load a previously saved Limit Line table. However, you need to
specify which limit line number you want loaded. See“Loading aFile” on

page 31.
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Using Loss Compensation

Using L oss Compensation

You can configure the NFA to compensate for losses due to cabling,
connectors and temperature effects that occur in the measurement setup.
These can be between the Noise Source and the DUT, Before DUT, and/or
between the DUT and the NFA input, After DUT.

You can aso use S2P data file formats output from a Network Analyzer to
create Loss Compensation tables. The NFA converts the S2P file format to a
Loss Compensation table. If you are using S2P file formats see the User’s
Guide for an explanation.

Configuring Fixed L oss Compensation

Pressthe Loss Comp key

Press the Setup menu key to accessthe Loss Compensation Setup
form, see Figure 3-2

L oss Compensation Setup Form

- Agilent I Before Comp
Before DUT Off

Off
Loss Compensation Setup
Fixed
Before DUT Off
Before DUT Fixed Value Table
Before Temperature 6.08 K —
After DUT 0ff

After DUT Fixed Value
After Temperature B.00 K

Mowve the highlight to select a field using the 'Tab' keys.
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Advanced Features
Using Loss Compensation

When configuring loss compensation before the DUT, use the Tab key to
navigate to the Before DUT field and set before DUT to fixed by selecting
the Fixed menu key to highlight it.

To set the loss compensation value before the DUT, use the Tab key to
navigate to the Before DUT Fixed Value field and input the required value
for the loss occurring before the DUT.

When configuring loss compensation after the DUT, use the Tab key to
navigate to the After DUT field and set after DUT to fixed by selecting the
Fixed menu key to highlight it.

To set the loss compensation value after the DUT, use the Tab key to navigate
to the After DUT Fixed Value field and input the required value for the loss
occurring after the DUT.

Configuring Table L oss Compensation

Pressthe Loss Comp key

Press the Setup menu key to accessthe L.oss Compensation Setup
form.

When configuring table loss compensation before the DUT, use the Tab key
to navigate to the Before DUT field and select the Table menu key to
highlight it.

When configuring table loss compensation after the DUT, use the Tab key to
navigate to the After DUT field and select the Table menu key to highlight it.

NOTE

You can load a previously saved L oss Compensation table. However, you
need to specify whether the Loss Compensation tableis an After Table or a
Before Table. See“Loading aFile” on page 31.
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Creating a L oss Compensation Table
To create aloss compensation table .
Press the Loss Comp key, and the Before Table menu key.

Enter the Loss Frequency value in the table using the numeric keys.
Terminate it using the unit menu keys.

Press the Tab key to move the highlight to the L oss Value column and enter
the corresponding Loss Value.

When terminating the Loss Value you can use either dB or linear menu
keys. However, the result appearsin the table in dB.

Press the Tab key to move the highlight to the L oss Frequency column and
enter the next Loss Frequency Va ue.

Repeat steps 2 to 4 until all the Loss Frequency and Loss Values you need
are entered.

After completing the Loss Compensation table entries, pressthe Prev key or
Loss Comp key to return to the Loss Compensation menu.

Once you have completed entering the L oss Compensation data, save the
Loss Compensation table using the File key.

NOTE

If you do not save the Loss Compensation table, you may lose the data. This
depends on your Power On/Preset condition.
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Setting Temperature of L oss

Sep 1. PressthelLoss Comp key

Sep 2. Pressthe Setup menu key to accessthe Loss Compensation Setup

form, see.

L oss Compensation Setup Form with Temperature Selected

Before DUT Off

Loss Compensation Setup

Before DUT
Before DUT Fixed Value
Before Temperature

After DUT
After DUT Fixed Value
After Temperature

Off
o
294.08 K

Off
R
384,08 K

Mowve the highlight to select a field using the 'Tab' keys.

| Before Comp

Off
Fixed

Table

Sep 3. To set the temperature value before the DUT, use the Tab key to navigate to
the Before Temperature field and input the required temperature of loss

value occurring before the DUT.

Sep 4. To set the temperature value after the DUT, use the Tab key to navigate to
the After Temperature field and input the required temperature of lossvalue

occurring after the DUT.
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Making Manual M easurements

The Noise Source is turned on or off by the appropriate Noise Source(On)
and Noise Source(Off), for example, Noise Source(On) provides Phot.

The following paragraphs give a step-by-step procedure for making the
measurement. Several steps are required for measurements at each
frequency point.

NOTE

When calibrating a series of frequency points and an error is made on one of
the points, you need to start calibrating the series of frequency points again.
Press the Calibrate key to reset the calibration.

NOTE

When measuring a series of frequency points and an error is made on one of
the points, you need to start measuring the series of frequency points again.
Press the Restart key to reset the measurement.

M anual M easurements Procedure

NOTE

Between each stage of this procedure, ensure you wait until the datainvalid
indicator has disappeared before you proceed.

Sep 1.

Sep 2.

The steps of atypical measurement are as follows:
Find and hold RF/UW attenuators.

1. Connect the hot source, Ty, to the DUT input, and the DUT output to the
NFA.

2. PressNoise Source(On) to measure noise power with the source at Ty,

3. Press RF/mW Att(Hold) to hold RF attenuators for the entire
measurement.

Cdlibrate.
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5.
6.

Remove the DUT and connect the noise source to the NFA
Press Calibration (On) to calibrate with noise source at Phot.

PressIF Att(Hold) to hold the I F attenuators fixed at the new value or use
the previously defined IF Att(Fixed) value.

Press Accept to store the Phot calibration reading.
Press Noise Source(Off) to select the Pcold calibration reading.
Press Accept to store the Pcold calibration reading.

Measure.

1.

o

Press Calibration (Off).

2. Connect Noise Source to the DUT and the DUT to the NFA.
3. PressNoise Source(On) to select the Phot reading.

4.
5

Press IF Att(Auto) to allow the I F attenuators to autorange.

. PressIF Att(Hold) to hold the IF attenuators fixed at the new value or use

the previously defined IF Att(Fixed) value.
Press Accept to store Phot measurement result.

Press Noise Source(Off) and press Accept to store Pcold measurement.

NOTE

If you have set up to measure a number of points over afrequency range.
You need to change the point number by pressing the Point menu key and
entering the point number and repeat the procedure from the next
measurement point. Repeat this until al the points have been measured.

The points need not be measured sequentially.
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Making Extended Frequency
M easurements

This chapter describes how to make measurements outside the baseband
frequency range of your Noise Figure Analyzer.
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What You will Find in this Chapter

This chapter covers:
* Overview of Configuring Extended Frequency Measurements
* Anoverview of the Measurement Modes

e Connecting the System
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Overview of Configuring Extended Frequency
M easurements

Configuring extended frequency measurements involves four steps.

Sep 1. Pressthe System key and configure the measurement system parameters as
required using the GPIB and External LO menu items.

Table4-1 System Parameters

Parameter Description

NFA Address This sets the NFA's GPIB address.
Valid addresses are from O to 30.
The default addressiis 8.

External LO Address This sets the GPIB address of the
Externa LO attached to the LO GPIB
port.

Valid addresses are from 0 to 30.

The default address is 19.

LO GPIB Address This sets the address through which
other devices, attached to the LO GPIB,
communicate with the NFA.

Valid addresses are from 0 to 30.

The default addressis 8.

Command Set This sets the External LO command
language. The default setting is
Command Set(SCPI) to operate a SCPI
compliant LO. Command Set(Custom)
is used when the External LO is not
SCPI compliant and operated using the
custom command strings.

LO Commands This accessesthe External LO
Commands Form. Theformisused to
enter the commands used to control a
non-SCPI-compliant External LO.
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Table4-1 System Parameters

Parameter Description

Settling Time This sets the settling time of the
External LO. Thisis used as a settling
period after the External LO frequency
is changed.

Min and Max Frequency This sets the minimum and maximum
frequencies of the External LO.

Sep 2. Pressthe Meas Mode key to configure the measurement mode of the Noise
Figure Analyzer.

For more details on the available measurement modes, see “ Measurement
Modes’ on page 91.

Sep 3. Pressthe Mode Setup key to configure the measurement mode parameters
for the specific measurement mode you have selected.

Sep 4. Configure the measurement (measurement frequency range, number of
measurement points and averages and so forth) using the Frequency/Points
and Averaging/Bandwidth keys.

For more details on configuring measurements, including calibration, see
Chapter 2, “Making Basic Measurements,” on page 35.
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Measurement Modes

M easurement M odes

The Noise Figure Analyzer offers the following measurement modes
through the Meas Mode key on the front panel:

The DUT isan amplifier-type device with no frequency conversion. This
is the basic measurement mode where the measurement frequency is
within the NFA’s frequency range.

The DUT is an amplifier-type device with frequency downconversion
occurring in the measurement test setup (system downconversion). The
LO can be either fixed or variablein this case.

The DUT is afrequency downconverter (that is, frequency
downconversion occursin the DUT itself and not in the measurement test
setup). The LO can be fixed or variable.

The DUT isafrequency upconverter (that is, frequency up conversion
occursin the DUT itself and not in the measurement test setup). The LO
can befixed or variable.

NOTE

The Amplifier measurement modeis for any DUT that does not perform
frequency conversion and includes amplifiers, filters, attenuators and so
forth.

Noise figure measurements involving mixers are necessary when:

The frequency conversion is part of the DUT. For example, the DUT isa
MixXer or areceiver.

The frequency conversion is part of the measurement test set-up. The
DUT isto be measured at a higher frequency than the NFA's frequency
range covers, hence an external mixer and local oscillator are added to
the measurement test set-up to convert this frequency to a frequency
within the NFA's range.
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Figure4-1

Making Extended Frequency Measurements
Measurement Modes

The NFA can make a single frequency conversion, either in the DUT, or as
an added System Downconverter, which configures the NFA asa
frequency range extender. The NFA can also control an LO source remotely
using the SCPI commands or the custom commands. Under this control the
L O can be swept.

Basic M easurement — No Frequency Conversion

The basic measurement setup is shown in Figure 4-1, allowing you to
compare more complex setups with it.

Basic Noise Figure Measurement — No Frequency Conversion
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When an uncorrected measurement is performed, the result is the measured
Noise Figure of all of the components after the noise source. When the
calibration setup is connected and the calibration performed, the NFA
measures its own noise figure and the connection set up. When a corrected
measurement is performed, the contribution of the calibration setup is
removed from the uncorrected result, giving a corrected measurement of the
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DUT only.

For these measurements the NFA mode is set to

Making Extended Frequency Measurements

DUT

Amplifier

System Downconverter

Off

Measurement Modes

NOTE

The RF input section on all NFA models has a built-in 3.0 GHz Low Pass
Filter. Thisfilter needs to accounted for when planning your filter
requirements during calibration and measurement.

NOTE

On the N8974A and the N8975A models the microwave input section hasno
filtering. This needsto accounted for when planning your filter requirements

for calibration and measurement. Thisis also important when making
measurements which cross over the 3.0 GHz switch.
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Frequency Down-converting DUT

In this mode, the DUT contains a frequency down-converting device, for
example, amixer or receiver.

There are two modes to choose from:
1. A variablefrequency LO and fixed IF.

Making this measurement, the NFA remains|ocked at one frequency and
the LO sweeps.

2. A fixed frequency LO and variable IF.

Making this measurement, the LO remains locked at one frequency and
the NFA sweeps.

NOTE

Filtering is needed to remove the unwanted sideband when making
single-sideband measurements in both modes. I deally these filters should be
included in the calibration path and measurement path. However, if it is not
in the path, you can enter |oss compensation to account for any additional
error.
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Fixed |F Variable LO (8970B Mode 1.3)
Thisis an overview of the key presses needed to set up the mode.

In the Measurement Mode Form Set the following:

DUT Downconv
System Downconverter No Access
LO Mode Variable

Inthe Mode Setup Form set the following:

IF Frequency

Enter avalue

Sideband

LSB, USB or DSB

LO Control

On

External LO Power Level

Enter value and

terminate using either
dBm or W

NOTE The External LO Power Level is displayed on the NFA asdBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)
frequencies.
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Making Extended Frequency Measurements
Measurement Modes

Variable |F Fixed LO (8970B Mode 1.4)
These are an overview of the key presses needed to set up the mode.

In the Measurement Mode Form Set the following:

DUT Downconv

System Downconverter No Access

LO Mode Fixed

IntheMode Setup Form set the following:

LO Frequency Enter avalue
Sideband LSB, USB or DSB
LO Control Off or On

External LO Power Level | Enter vaue and
terminate using either
dBm or W

NOTE The External LO Power Level is displayed on the NFA asdBm.

In the Frequency menu, frequencies are specified as | F (output from DUT)
frequencies.
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Making Extended Frequency Measurements
Measurement Modes

Frequency Up-converting DUT

In this mode, the DUT contains a frequency up-converting device, for
example, atransmitter.

There are two modes to choose from:
1. A variablefrequency LO and fixed IF.

Making this measurement, the NFA remains|ocked at one frequency and
the LO sweeps.

2. A fixed frequency LO and variable IF.

Making this measurement, the LO remains locked at one frequency and
the NFA sweeps.
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Making Extended Frequency Measurements

Measurement Modes

Fixed IF Variable LO (8970B Mode 1.3 with SUM Sideband)

These are an overview of the key presses needed to setup using thismode. In
this mode, the DSB measurement is not allowed.

In the Measurement Mode Form Set the following:

DUT Upconv
System Downconverter No Access
LO Mode Variable

IntheMode Setup Form set the following:

IF Frequency Enter avalue
Sideband LSB or USB
LO Control On

External LO Power Level | Enter value and

terminate using either
dBm or W

NOTE

The External LO Power Level is displayed on the NFA asdBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)

frequencies.
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Making Extended Frequency Measurements
Measurement Modes

Variable | F Fixed LO (8970B Mode 1.4 with SUM Sideband)

These are an overview of the key presses needed to set up using this mode.
In this mode, the DSB measurement is not allowed.

Inthe Measurement Mode Form Set thefollowing:

DUT Upconverter
System Downconverter No Access
LO Mode Fixed

IntheMode Setup Form set the following:

LO Frequency Enter avalue
Sideband LSB or USB
LO Control Off or On

External LO Power Level

Enter value and
terminate using either
dBm or W

The External LO Power Level isdisplayed on the NFA asdBm.

In the Frequency menu, frequencies are specified as |F (output from DUT)

frequencies.
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Making Extended Frequency Measurements
Measurement Modes

System Downconverter

The DUT isanon-frequency converting device, for example an amplifier or
filter, and its frequency is higher than the NFA’'s measurement range.
Frequency down-conversion is required within the measurement system,
using a mixer, external to the DUT, to convert the signal of interest to the
frequency range of the NFA.

There are two modes to choose from:
1. A variablefrequency LO and fixed IF.

Making this measurement, the NFA remains locked at one frequency and
the LO sweeps.

2. A fixed frequency LO and variable IF.

Making this measurement, the LO remains locked at one frequency and
the NFA sweeps.

NOTE

Filtering is needed to remove the unwanted sideband when making
single-sideband measurements in both modes. Ideally any filtering is
included in the calibration path and measurement path. However, if it is not
in the path, you can enter loss compensation to account for any additional
error.
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Making Extended Frequency Measurements

Fixed |F Variable LO (8970B Mode 1.1)

Measurement Modes

These are an overview of the key presses needed to set up using this mode.

In the Measurement Mode Form Set the following:

DUT Amplifier
System Downconverter On
LO Mode Variable

Inthe Mode Setup Form set the following:

IF Frequency

Enter avalue

Sideband

LSB, USB or DSB

LO Control

On

External LO Power Level

Enter value and

terminate using either
dBm or W

NOTE The External LO Power Level is displayed on the NFA asdBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)
frequencies.
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Making Extended Frequency Measurements
Measurement Modes

Variable | F Fixed LO (8970B Mode 1.2)
These are an overview of the key presses needed to set up using this mode.

In the Measurement Mode Form Set the following:

DUT Amplifier

System Downconverter On

LO Mode Fixed

IntheMode Setup Form set the following:

LO Frequency Enter avalue
Sideband LSB or USB
LO Control Off or On

External LO Power Level | Enter vaue and
terminate using either
dBm or W

NOTE The External LO Power Level is displayed on the NFA asdBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)
frequencies.
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Making Extended Frequency Measurements
Connecting the System

Connecting the System

Figure 4-2 and Figure 4-3 show the connection diagram options you can use
to calibrate the NFA and after calibration, to measure a DUT, whether itisa
down-converter mixer, up-converter mixer, amplifier, or filter. It does not
show where to place afilter to remove any unwanted sideband or input
noise.

Setting Up the Noise Figure Analyzer

To connect the NFA to make measurements.

Connect a GPIB cable between the NFA's LO GPIB rear panel connector
and the Local Oscillator’s GPIB connector.

Turn on both instruments and press the Preset key to return the NFA to a
known state.

The NFA can control the Local Oscillator, over its General Purpose Interface
Bus (LO GPIB) without the need for an external controller. The NFA does
not send L O controlling commands over it'smain GPIB. LO control is only
done over it's LO GPIB.

Enter the ENR valuesin to the NFA. See “Entering Excess Noise Ratio
(ENR) Data’ on page 37 for the proceduresto do this.

Follow the procedure to calibrate the system, and measure the DUT, in the
mode to suit your needs.
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Making Extended Frequency Measurements
Connecting the System

Figure4-2 System Downconverter Mode
e =
N S5
Calibration Setup anaoao ||
Noise Source [sN=lsNslsls] §§§o®
:-|:| Hi— A o
nNo nNo
J
LO
Measurement Setup =0
oo
=
838
Noise Source 388
DUT = rr\\’, @)
Y]
J
Figure4-3 Freguency Converting DUT Measurement M odes
o
Calibration Setup =
a
o
Noise Source 3
L0 00 000 —| o
[d:h] > O
J
LO
2 LO'GPIB Control =
M easurement Setup RN =]
o
o

Noise Source

.
. >
| DUT
J

O||cooo

20
B

v emw

104 Chapter4



Performing System Operations

This chapter describes how to perform the system-level tasks, such as
configuring the Noise Figure Analyzer’s GPIB address, defining the preset

conditions and so forth.
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Performing System Operations
What You will Find in this Chapter

What You will Find in this Chapter

This chapter covers:

Setting the GPIB Addresses

Configuring the Serial Port

Configuring the Internal Alignment

Displaying Error, System and Hardware |nformation
Presetting the Noise Figure Analyzer

Defining the Power-On/Preset Conditions

Restoring System Defaults

Setting the Time and Date

Configuring a Printer with the NFA
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Sep 3.

Performing System Operations
Setting the GPIB Addresses

Setting the GPIB Addresses

To Set the GPIB Addresses

Press the System key

Pressthe GPIB menu key.
System GPIB Form

INFHHddress

Noise Figure Analyzer Address 8
N R R R R, wrpddress
8

System GPIB Form

Noise Figure Analyzer Address|s

External LO Address 13
LO GPIE Address 8

Move the highlight to select a field using the 'Tab keys.

Using the Tab key to navigate through the form configure the GPIB
parameters as required.

For adescription of the GPIB parameters, see the analyzer online help or the
User’'s Guide.

NOTE

Ensure the Remote Port menu key is set Remote Port(GPIB).
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Performing System Operations
Configuring the Serial Port

Configuring the Serial Port

Sep 1. Pressthe System key
Sep 2. Pressthe Serial menu key.
The System Serial Form now appears. See Figure 5-2
Figure5-2 System Serial Form
| Baud
Baud 9600
- 1200
System Serial Form
2400
Data Terminal Ready OFF
Request To Send OFF 4800
Baud 9600 P
Receive Pacing KON/ KOFF 9600
Transmit Pacing KON/ KOFF
19200
38400
Move the highlight to select a field using the 'Tab' keys.
Sep 3. Usethe Tab keysto navigate through the form and the menu keysto
configure the serial parameters as required.
For a description of the serial parameters, see the analyzer online help or the
User's Guide.
NOTE Ensure the Remote Port menu key is set Remote Port(Serial). The NFA

needs a power cycle to take effect if you changed it from
Remote Port(GPIB),
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Performing System Operations
Configuring the Internal Alignment

Configuring the Internal Alignment

Datafrom the internal alignment routine is necessary for accurate NFA
operation. When enabled, the internal alignment routine runs continuously to
ensure that the NFA isusing current alignment data which improves the
NFA's accuracy.

Turning Alignment Off and On
Press the System key.

Press the Alignment menu key to access the Alignment menu.

Pressthe Alignment menu key selecting Alignment(On) or Alignment(Off)
as required.

The default setting is Alignment(On).

Changing Alignment Mode

Press the System key.
Press the Alignment menu key to access the Alignment menu.

Press the Alignmnt Mode menu key selecting Alignmnt Mode(Point) or
Alignmnt Mode(Sweep) as required.

The default mode setting is Alignmnt(Sweep).
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Performing System Operations
Configuring the Internal Alignment

Alignment of the YIG Tuned Filter (YTF)

NOTE The YTF alignment feature only applies to the N8974A and the N8975A
models.

Sep 1. Pressthe System key.
Sep 2. Pressthe Alignment menu key to access the Alignment menu.
Sep 3. Pressthe Align YTF menu key to set the Y TF alignment.

You are prompted to press this key again. This feature ensures you do not
accidently erase the current Y TF alignment data.

Sep 4. Wait until the Alignment routine has compl eted.
Sep 5. Pressthe Save YTF Alignment menu key to store the Alignment data.
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Performing System Operations
Displaying Error, System and Hardware Information

Displaying Error, System and Hardware I nfor mation

Displaying the Error History

Press the System key and the More 1 of 3 menu key.
Press Show Errors menu key to view the error queue.

To clear the error screen, press Clear Error Queue.

Displaying System Information

Press the System key and the More 1 of 3 menu key.

Press Show System menu key to view system information.

Displaying Hardware Information

Press the System key and the More 1 of 3 menu key.

Press Show Hdwr menu key to view hardware information.
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Performing System Operations
Presetting the Noise Figure Analyzer

Presetting the Noise Figure Analyzer

To preset the analyzer using its factory defaults:

Turn the NFA on by pressing the On key and wait for the power on process
to complete.

Press System key, More 1 of 3, Power On/Preset, Preset (Factory) menu
keys.
Press the green Preset key.

NOTE

Turning on the analyzer performs an instrument preset. Turning on the
analyzer also fetches alignment data; clears both the input and output
buffers; and sets the status byte to 0. The last state of the analyzer before it
was turned off is recalled when Power On(Last) is selected (under the

System key).
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Performing System Operations
Defining the Power-On/Preset Conditions

Defining the Power-On/Preset Conditions

The power up and preset conditions can be different if required. You can set
the NFA to return it to a user-defined state after a power on or preset.

Setting the Power On Conditions

Press the System key and the More 1 of 3 menu key.
Press the Power On/Preset menu key.
Set Power On to Power On(Last) or Power On(Preset) as required.

‘Last’” means that the instrument, upon power on returnsto the state it wasin
when it was powered off.

‘Preset’ means the instrument returnsto its defined preset state.
Setting the Preset Conditions

You can set the NFA to return to its factory default state or a user defined
state upon preset. The configured user defined state is provided by pressing
the Save User Preset menu key to save the current NFA state

To set the preset conditionsto factory default
Press the System key and the More 1 of 3 menu key.
Press the Power On/Preset menu key.

Enable the Preset(Factory) menu key.

To set the preset conditionsto user defined
Configure the NFA to the desired stete.

Press the System key and the More 1 of 3 menu key.
Press the Power On/Preset menu key.

Enable the Preset(User) menu key.

Press the Save User Preset menu key to save the current NFA state.

Chapter 5 113



Performing System Operations
Restoring System Defaults

Restoring System Defaults

Sep 1. Pressthe System key
Sep 2. Pressthe More 1 of 3 menu key.

Sep 3. Pressthe Restore Sys Defaults menu key.
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Performing System Operations
Setting the Time and Date

Setting the Time and Date

To turn thetime and date on and off

Pressthe System key.

Press the More 1 of 3 menu key.

Press the Time/Date menu key.

Press the Time/Date menu key to select Time/Date(On) or Time/Date(Off)
as required.

To set thetime and date

Press the System key.
Pressthe More 1 of 3 menu key.
Press the Time/Date menu key.

Set the Date Mode to either USformat MDY (Month/Day/Year) or European
format DMY (Day/Month/Year).

Enter the time in hhmmss (hours, minutes, seconds) format.

Enter the date in yyyymmdd (year, month, day) format.
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Performing System Operations
Configuring a Printer with the NFA

Configuring a Printer with the NFA

To connect your printer to the NFA, connect the printer to the paralel 1/0
interface connector of the NFA using an |EEE 1284 compliant parallel
printer cable.

If appropriate, configure your printer (see your printer documentation for
more details on configuring your printer).

To Configurea Printer with the NFA

Power on the NFA and the printer.

Press the Print Setup key and then press the Printer Type menu key. Refer
to the analyzer online help or User’s Guide for a description of the options.

Press Printer Type to access the Printer Type menu keys and press Auto to
make the NFA attempt to identify the connected printer.

The printer should now be automatically recognized by the NFA. If the
printer is not automatically recognized, then see the User’s Guide for more
details on printer setup.

Testing Correct Printer Operation

When printer setup is complete test correct printer operation by pressing
Print Setup, Print (Screen) and then pressing the Print key to print a test

page.
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Symbols
Itit, 117

Numerics

10 MHzrefin, 21

10 MHz ref out, 21
3.0 GHz switch, 15
3.5 mm connector, 15

A

active function, 23
address GPIB, 107
alignment, 109
annotation, 24

arrow keys, 18
AUXIN (TTL), 21
AUX OUT (TTL), 21
Averaging, 54

B

band pair marker, 70
Bandwidth, 54

C

calibration, 55
performing, 55
Configuring
Extended Frequency
Measurements, 89
configuring
alignment mode, 109
alignment YTF, 110
GPIB address, 107
|oss compensation
fixed value, 81
table value, 82
serial port, 108
temperature loss, 84
Connecting

NFA for extended measurements,
103
connector
10 MHzref in, 21
10 MHz ref out, 21
50 ohm input, 18
APC35mm, 18
AUX IN (TTL), 21
AUX OUT (TTL), 21
external keyboard, 18
GPIB, 21
LOGBIB, 21
noise source output, 18
paralel port, 21
probe power, 18
RS-232 port, 21
service, 20
SNS, 19
Type-N, 18
VGA, 21
CONTROL functions, 17
copy files, 32
creating
frequency list, 51

D

datainvalid indicator, 25
deletefiles, 33
deltamarker, 70
disk format, 28
display
combining graph, 63
display reference, 67
format, 59
full screen, 60
memory trace, 64
scaling, 65
single graph, 62
display annotation, 24
DISPLAY functions, 17
Displaying
Error History, 111

displaying
hardware information, 111
system information, 111
Downconverting
Fixed IF Variable LO, 95
Variable IF Fixed LO, 96

E

ENR, 37
ENR spot value, 43
ENR table calibrate, 38
ENR table common, 37
ENR table measurement, 38
ENR table normal dataentry, 38
entering normal ENR data, 38
Error queue
clearing, 111
error queue, 111
Esc key, 16
Excess Noise Ratio, 37
external keyboard connector, 18

F

file copying, 32
file deleting, 33
fileloading, 31
file menu functions
copy, 32
delete, 33
format, 28
load, 31
rename, 31
save, 30
filerenaming, 31
file saving, 30
fixed ENR, 43
Fixed value loss compensation, 81
floppy disk format, 28
format, 59
format adisk, 28
freq mode
fixed, 50

Index
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list, 50
sweep, 50
frequency list
creating, 51
using swept points, 53
using thefill, 53
front panel input connector,precision
3.5 mm connector, 15
front panel overview, 16
full screen, 60
full span, 50
fuse, 20

G

GPIB address, 107
setting, 107
GPIB annunciators, 25

H

hardware information
displaying, 111
help key, 18

|
input
power, 20
INPUT 50 OHM, 18
input attenuation range microwave,
57
Input Attenuation Range RF, 57
instrument preset, 112
intensity
viewing angle, 16

K

key overview, 23
key presses
Fixed IF Variable LO
(Downconvert), 95
Fixed |F Variable LO (System
Downconvert), 101, 102

Fixed IF Variable LO (Upconvert),
98

Variable |IF Fixed LO
(Downconvert), 96

Variable IF Fixed LO (Upconvert),
99

L

limitline1, 79

limitline 2, 79

limit line 3, 79

limit line 4, 79

LOGBIB, 21

load files, 31

loss compensation configuring, 81,
82

loss compensation use, 81

M

MAIN GPIB, 21
manual measurement procedure, 85
manual measurements, 85
Marker 1, 68
Marker 2, 68
Marker 3, 68
Marker 4, 68
marker state
delta, 70
markers
band pair, 70
selecting, 68
states, 70
marking memory traces, 72
MEASURE functions, 17
Measurement Modes
Frequency-Downconverting, 94
Frequency-Upconverting, 97
Overview, 91
System Downconvertor, 100
mechanical 3.0 GHz switch, 15
menu keys, 16

methods of normal ENR data entry,
38

microwave front panel connector, 15

microwave input attenuation range,
57

mode

fixed frequency, 53
monitor output, 21

N

next window, 18
NFA features, 15
noise source
model number, 39
serial number, 39
noise source normal, 37
noise source output, 18
noise source smart, 37
normal noise source, 37
numeric keys, 18

(0]

Overview
Extended Frequency
Measurements, 89
Measurement Modes, 91

P

parallel connector, 21
power input, 20
Power-On conditions

defining, 113
Preset, 112

defining conditions, 113
Preset key, 17
pressing full span, 50
printer output, 21
printing, parallel

deskjet, 116

epson, 116

laserjet, 116

paintjet, 116
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thinkjet, 116
probe power connector, 18

R

rear panel features, 20

rear panel overview, 20

ref level, 67

renamefiles, 31

RF Input Attenuation Range, 57
RPG, 18

RS-232 connector, 21

S

savefiles, 30
saving
ENR table data, 42
scaling, 65
selecting afixed freg, 53
selecting markers, 68
serial data output, 21
seria port
setting up, 108
setting
GPIB address, 107
seria port, 108
setting Tcold, 47
setting the microwave input
attenuation, 58
setting Thot, 44
Setting up
NFA for extended measurments,
103
setting up limit lines, 79
Smart Noise Source (SNS), 37
SNS connector, 19
spot ENR, 43
spot Thot, 44
switch reliability, 15
System Downconvertor
Fixed IF Variable LO, 101, 102
SYSTEM functions, 17

T

Tab Keys, 18

table value loss compensation, 82
tcold data changing, 47, 48, 49
Tcold setting, 47

temperature correction, 47, 48, 49
temperature loss configuring, 84
Thot spot value, 44

torque value, 15

u

Upconverting
Fixed IF Variable LO, 98
Variable IF Fixed LO, 99
using tables, 34

\Y,

VGA connector, 21
video connector, 21
viewing angle, 16

W
working with tables, 34

Y
YTF aignment, 110

Z
zoom, 18
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